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1. Related Manuals 
 
To ensure system safety, make sure to always read and follow the information provided in all 
Safety Precautions and Precautions for Safe Use in the manuals for each device which is 
used in the system.  
The table below lists the manuals provided by CKD Corporation (hereinafter referred to as 
"CKD") and OMRON Corporation (hereinafter referred to as "OMRON"), which pertain to this 
guide.  
 

Manufacturer Cat. No.  Model Manual name 
OMRON W500 NJ501-□□□□ 

NJ301-□□□□ 
NJ101-□□□□ 

NJ-series CPU Unit  
Hardware User's Manual 

OMRON W535 NX701-□□□□ NX-series CPU Unit  
Hardware User's Manual 

OMRON W593 NX102-□□□□ NX-series  
NX102 CPU Unit  
Hardware User's Manual 

OMRON W578 NX1P2-□□□□ NX-series  
NX1P2 CPU Unit  
Hardware User's Manual 

OMRON W501 NX701-□□□□ 
NX102-□□□□ 
NX1P2-□□□□ 
NJ501-□□□□ 
NJ301-□□□□ 
NJ101-□□□□ 

NJ/NX-series  
CPU Unit  
Software User's Manual 

OMRON W506 NJ/NX-series  
CPU Unit Built-in EtherNet/IPTM Port  
User's Manual 

OMRON W504 SYSMAC-SE2□□□ Sysmac Studio Version 1 
Operation Manual  

OMRON 0969584-7 W4S1-05□ 
W4S1-03B 

Switching Hub   
W4S1-series 
Users Manual  

CKD SMF-2006-A AX9000TS/TH/XS INSTRUCTION MANUAL 
ABSODEX AX SERIES  
TS TYPE TH TYPE XS TYPE 

CKD SMF-2012-A AX9000TS/TH-U6 Instruction Manual ABSODEX AX Series 
TS type TH type EtherCAT specification 
EtherNet/IP specification 

CKD SMF-2005-A – INSTRUCTION MANUAL ABSODEX 
AX Tools for Windows® 
Common for TS-Type, TH-Type, 
MU-Type and XS-Type Drivers 
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2. Terms and Definitions 
 
The terms and definitions used in this guide are given below.  
 

Term Explanation and Definition 
node A node refers to a relay point, a junction point or an end point on an 

EtherNet/IP network made up of devices having an EtherNet/IP port.  
A device with one EtherNet/IP port is recognized as one node and two 
EtherNet/IP ports as two nodes on an EtherNet/IP network.  

tag A tag is a unit that is used to exchange data with tag data links.  
Data is exchanged between the local network variables and remote 
network variables specified in the tags or between specified I/O memory 
areas.  

tag set When a connection is established, from 1 to 8 tags (including Controller 
status) is configured as a tag set. Each tag set represents the data that is 
linked for a tag data link connection. Tag data links are therefore created 
through a connection between one tag set and another tag set.  
A tag set name has to be set for each tag set.  

tag data links The standard EtherNet/IP implicit communications are called tag data 
links. Tag data links enable cyclic tag data exchanges on an EtherNet/IP 
network between Controllers or between Controllers and other devices.  

connection A connection is used to exchange data as a unit within which data 
concurrency is maintained.  

connection type There are two kinds of connection types for tag data links.  
One is a multi-cast connection, and the other is a unicast (point-to-point) 
connection. The multi-cast connection sends an output tag set in one 
packet to more than one node. The unicast connection separately sends 
one output tag set to each node. Therefore, the multi-cast connection 
can reduce the communications load if one output tag set is sent to more 
than one node. 

originator and target To perform tag data links, it is necessary to open connections between 
nodes that perform tag data links. The node that requests the connection 
is called the originator, and the node that receives the request is called 
the target.  

tag data link 
parameters 

The information that is set to perform tag data links, including tags, tag 
sets and connections, is called tag data link parameters.  

EDS file A file that describes information unique to a device such as the number 
of I/O points for an EtherNet/IP device.  
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3. Precautions 
 
(1) Understand the specifications of devices which are used in the system. Allow some 

margin for ratings and performance. Provide safety measures, such as installing a safety 
circuit, in order to ensure safety and minimize the risk of abnormal occurrence.  

(2) To ensure system safety, make sure to always read and follow the information provided 
in all Safety Precautions and Precautions for Safe Use in the manuals for each device 
which is used in the system.  

(3) The user is encouraged to confirm the standards and regulations that the system must 
conform to.  

(4) It is prohibited to copy, to reproduce, and to distribute a part or the whole of this guide 
without the permission of OMRON Corporation.  

(5) The information contained in this guide is current as of October 2018. It is subject to 
change for improvement without notice.  

 
The following notations are used in this guide.  
 

 

Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury, or may result in serious 
injury or death. Additionally there may be significant property 
damage. 

 

 
Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury or property damage. 

 
 

 Precautions for Correct Use 

Precautions on what to do and what not to do to ensure proper operation and performance.  

 

 Additional Information 
Additional information to read as required.  
This information is provided to increase understanding or make operation easier.  

 
Symbol 
  

 

The filled circle symbol indicates operations that you must do. 
The specific operation is shown in the circle and explained in the text. 
This example shows a general precaution for something that you must do. 
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4. Overview 
 
This guide describes procedures for connecting a CKD ABSODEX Driver AX9000TS/TH-U6 
(hereinafter referred to as the "ABSODEX Driver") to an OMRON NJ/NX-series Machine 
Automation Controller (hereinafter referred to as the "Controller") via EtherNet/IP and for 
checking the communication status.  
Refer to Section 6. EtherNet/IP Settings and Section 7. EtherNet/IP Connection Procedure to 
understand setting methods and key points to operate EtherNet/IP tag data links.  
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5. Applicable Devices and Device Configuration 
 

5.1. Applicable Devices 
The applicable devices are as follows: 
 

Manufacturer Name Model 
OMRON NJ/NX-series CPU Unit NX701-□□□□ 

NX102-□□□□ 
NX1P2-□□□□ 
NJ501-□□□□ 
NJ301-□□□□ 
NJ101-□□□□ 

CKD ABSODEX Driver AX9000TS-U6 
AX9000TH-U6 

CKD Actuator AX-T Series 
 

 Precautions for Correct Use 

In this guide, the devices with models and versions listed in 5.2. Device Configuration are 
used as examples of applicable devices to describe the procedures for connecting the 
devices and checking their connection.  
You cannot use devices with versions lower than those listed in 5.2.   
To use the above devices with models not listed in 5.2. or versions higher than those listed in 
5.2., check the differences in the specifications by referring to the manuals before operating 
the devices.  

 

 Additional Information 
This guide describes the procedures for establishing the network connection.  
It does not provide information on operation, installation, wiring method, device functionality, 
or device operation, which is not related to the connection procedures.  
Refer to the manuals or contact the device manufacturer.  

 

 Additional Information 
Contact the device manufacturer for information on Actuators connectable to the ABSODEX 
Drivers. 
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5.2. Device Configuration 
The hardware components to reproduce the connection procedures in this guide are as 
follows:  
 
 
 
 
 
 
 
 
 

Manufacturer Name Model Version 
OMRON NX series CPU Unit 

(Built-in EtherNet/IP ports) 
NX102-1200 Ver.1.31 

– Power supply (24 VDC for the Controller) –  
OMRON Switching hub W4S1-05C Ver.1.0 
– Switching hub power supply (24 VDC) －  
OMRON Sysmac Studio SYSMAC-SE2□□□ Ver.1.24 
OMRON Network Configurator (provided in Sysmac 

Studio package) 
Ver.3.65 

– Personal computer (OS: Windows 10) –  
– LAN cable (STP (shielded, twisted-pair) 

cable of Ethernet category 5 or higher) 
–  

CKD ABSODEX Driver AX9000TS-U6 Ver.10.01 

CKD RS-232C cable AX-RS232C-9P  
CKD Actuator AX4009T  
CKD AXTools – Ver.2.22 

CKD EDS file AX9000TS-U6.eds Ver.1.4 
– External power supply  

(24 VDC for the ABSODEX Driver) 
–  

 

 Precautions for Correct Use 

Prepare beforehand the EDS file specified above.  
To obtain the EDS file, contact CKD Corporation. Please note that you need the EDS file 
relevant to your device. If you use the other model of the ABSODEX Driver (not the one 
specified above), contact CKD Corporation and obtain the relevant EDS file.  

 

 Precautions for Correct Use 

Update Sysmac Studio and Network Configurator to the versions specified above or to higher 
versions. If you use a version higher than the one specified, the procedures and related 
screenshots described in Section 7. and the subsequent sections may not be applicable.  
In that case, use the equivalent procedures described in this guide by referring to the Sysmac 
Studio Version 1 Operation Manual (Cat. No. W504) and Network Configurator Online Help.  

 

NX102-1200 
(Built-in EtherNet/IP ports) 

W4S1-05C 

AX9000TS-U6 Personal computer  
(Sysmac Studio, Network 
Configurator and AXTools 
installed, 
OS: Windows 10) 

LAN cable Power 
supply 

LAN cable 

AX4009T 

External 
power supply AX-RS232C-9P 

LAN cable Switching hub power supply 

2026/6/30 Discontinued



5．Applicable Devices and Device Configuration 

 7 

 Additional Information 
For information on power supply specifications of the Controller, refer to the NX-series 
NX102 CPU Unit Hardware User's Manual (Cat. No. W593).  

 

 Additional Information 
For information on power supply specifications of the switching hub, refer to the Switching 
Hub W4S1-series Users Manual (Cat. No. 0969584-7).  

 

 Additional Information 
For information on external power supply specifications for the ABSODEX Driver, refer to the 
Instruction Manual ABSODEX AX Series TS type TH type EtherCAT specification 
EtherNet/IP specification (SMF-2012-A). 
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6. EtherNet/IP Settings 
 
This section describes the parameters, global variables and tag sets that are all defined in this 
guide.  
 

6.1. Parameters 
The following parameters are required to connect the ABSODEX Driver and the Controller via 
EtherNet/IP. 
 

Setting item 
Controller 

PORT2 (EtherNet/IP) 
(Node 1) 

ABSODEX Driver  
(Node 2) 

IP address 192.168.1.1 192.168.1.2 
Subnet mask 255.255.255.0 255.255.255.0 

 
 

6.2. Global Variables 
The Controller treats data in tag data links as global variables.  
The following tables show the global variables and the related settings.  
 

Name Data type 
Network 
publish 

ABSODEX Driver  
data allocation 

Data size 
(byte) 

EIP002_InputSignal_OUT BYTE[8] Output 
Input signal from Controller to 
ABSODEX Driver 

8 

EIP002_MonitorCode_OUT DINT[3] Output Monitor codes 1 to 3 12 
EIP002_Command_OUT DINT[3] Output Command data 12 

EIP002_OutputSignal_IN BYTE[8] Input 
Output signal from ABSODEX 
Driver to Controller 

8 

EIP002_MonitorData_IN DINT[3] Input Monitor data 1 to 3 12 
EIP002_Response_IN DINT[3] Input Response data 12 

 

 Additional Information 
For information on monitor codes and monitor data, refer to 3.4.1. Monitor Code of the 
Instruction Manual ABSODEX AX Series TS type TH type EtherCAT specification 
EtherNet/IP specification (SMF-2012-A). 
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ABSODEX Driver input signal 
Global variable Bit Description 

EIP002_InputSignal_OUT[0] 0 to 3 Program number selection input (bits 0 to 3) 

4 Program number setting input, second digit / 
Program number selection input (bit 4) 

5 Program number setting input, first digit / 
Program number selection input (bit 5) 

6 Reset input 
7 Origin return command input 

EIP002_InputSignal_OUT[1] 0 Start input 

1 Servo-on input /  
Program stop input 

2 Ready return input /  
Continuous rotation stop input 

3 Answer input /  
Position deviation counter reset input 

4 Emergency stop input 
5 Brake off input 
6 Jog operation input (CW direction) 
7 Jog operation input (CCW direction) 

EIP002_InputSignal_OUT[2] 0 and 1 Reserved /  
Travel unit selection input (bits 0 and 1) 

2 Reserved / 
Travel speed unit selection input 

3 Table operation, data input operation 
Switching input 

4 to 7 Reserved 
EIP002_InputSignal_OUT[3] – Reserved 
EIP002_InputSignal_OUT[4] 0 Monitor output execution request 

1 Command code execution request 
2 to 7 Reserved 

EIP002_InputSignal_OUT[5]   
to – Reserved 

EIP002_InputSignal_OUT[7]   
 
Command data 

Global variable Description 
EIP002_Command_OUT[0] Command code 
EIP002_Command_OUT[1] Written data / A code or P code 
EIP002_Command_OUT[2] Data designation / F code 
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ABSODEX Driver output signal 
Global variable Bit Description 

EIP002_OutputSignal_IN[0] 0 to 7 M code output (bits 0 to 7) 
EIP002_OutputSignal_IN[1] 0 In-position output 

1 Positioning completion output 
2 Start input wait output 
3 and 4 Alarm output 1 and 2 

5 Indexing-in-progress output 1 / 
Origin position output 

6 Indexing-in-progress output 2 / 
Servo state output 

7 Ready state output 
EIP002_OutputSignal_IN[2] 0 Segment position strobe output 

1 M code strobe output 
2 to 7 Reserved 

EIP002_OutputSignal_IN[3] – Reserved 
EIP002_OutputSignal_IN[4] 0 Monitoring 

1 Command code execution complete 
2 to 7 Reserved 

EIP002_OutputSignal_IN[5]   
～ – Reserved 

EIP002_OutputSignal_IN[7]   
 
Response data 

Global variable Description 
EIP002_Response_IN[0] Response code 
EIP002_Response_IN[1] Loaded data 
EIP002_Response_IN[2] Reserved 

 

 Additional Information 
For more information on the allocations of the input and output areas, refer to 3.2. 
Input/Output of the Instruction Manual ABSODEX AX Series TS type TH type EtherCAT 
specification EtherNet/IP specification (SMF-2012-A). 

 

 Additional Information 
With Sysmac Studio, two methods can be used to specify an array for a data type.  
After specifying, (1) is converted to (2), and the data type is always displayed as (2).  

(1)BOOL[16] / (2) ARRAY[0..15] OF BOOL 
In this guide, the data type is simplified by displaying BOOL[16].  
(The example above means a BOOL data type with sixteen array elements.)  
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6.3. Tag Sets 
The tag sets to perform tag data links are shown below.  
The data in the tag sets are assigned in ascending order of the following OUT No. and IN No.  
 
Output area (Controller to ABSODEX Driver) 

Tag set name Data size (byte) 
EIP002_OUT 32 

 
OUT No. 

Tag name  
(global variable name) 

Data size (byte) 

 1 EIP002_InputSignal_OUT 8 
 2 EIP002_MonitorCode_OUT 12 
 3 EIP002_Command_OUT 12 

 
Input area (ABSODEX Driver to Controller) 

Tag set name Data size (byte) 
EIP002_IN 32 

 
IN No. 

Tag name  
(global variable name) 

Data size (byte) 

 1 EIP002_OutputSignal_IN 8 
 2 EIP002_MonitorData_IN 12 
 3 EIP002_Response_IN 12 
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7. EtherNet/IP Connection Procedure 
 
This section describes the procedures for connecting the ABSODEX Driver and the Controller 
via EtherNet/IP. The procedures for setting up the ABSODEX Driver and the Controller in this 
guide are based on the factory default settings.  
For information on initialization, refer to Section 8. Initialization Method.  
 

7.1. Work Flow 
Take the following steps to connect the ABSODEX Driver and the Controller via EtherNet/IP 
and perform tag data links.  

 
7.2. CKD ABSODEX Driver Setup  Set up the CKD ABSODEX Driver. 

↓   

 7.2.1. Cable Connection  Connect the cables to the ABSODEX Driver. 

↓   

 7.2.2. Parameter Settings   Set the IP address of the ABSODEX Driver. 

↓   

7.3. Controller Setup  Set up the Controller.  

↓   

 7.3.1. IP Address Settings  
Start Sysmac Studio and set the IP address of the 
Controller.  

↓   

 7.3.2. Setting Global Variables 
 

Set global variables to use for tag data links, and create 
and export a CSV file in order to use the variables as 
tags in Network Configurator.  

↓   

 7.3.3. Transferring the Project 
Data 

 
Go online with Sysmac Studio and transfer the project 
data to the Controller.  

↓   
7.4. Network Settings  Set EtherNet/IP tag data links.  

↓   

 7.4.1. Starting Network 
Configurator and Installing 
the EDS File  

 

Start Network Configurator and install the EDS file.  

↓   
 7.4.2. Uploading the Network 

Configuration 
 

Go online with Network Configurator and upload the 
network configuration.  

↓   
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 7.4.3. Tag Registration 
 

Import the created CSV file for use with Network 
Configurator, and register tags and tag sets.   

↓   
 7.4.4. Setting Connections 

 
Set connections to associate the tag sets of the target 
device with the tag sets of the originator device.  

↓   
 7.4.5. Transferring the Tag Data 

Link Parameters  
 

Transfer the tag data link parameters to the Controller.  

↓   

7.5. EtherNet/IP Communication 
Status Check 

 
Confirm that the EtherNet/IP tag data links are 
performed normally.  

↓   

 7.5.1. Checking the Connection 
Status 

 
Check the EtherNet/IP connection status.  

↓   

 7.5.2. Checking Sent and 
Received Data 

 
Check that correct data is sent and received.  
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7.2. CKD ABSODEX Driver Setup 
Set up the CKD ABSODEX Driver. 
 

7.2.1. Cable Connection 
Connect the cables to the ABSODEX Driver. 
 

 Precautions for Correct Use 

Before following the steps below, check the capacities of the main and control power supplies 
and wire them by referring to the INSTRUCTION MANUALABSODEX AX SERIES TSTYPE 
TH TYPE XS TYPE (SMF-2006-A). 

 

 Precautions for Correct Use 

Make sure that the power supplies are all OFF before setting up.  
If any of them are ON, the settings described in the following steps and subsequent 
procedures may not be applicable.  

 

1 Make sure that the following 
power supplies are all OFF. 
- Main and control power 
supplies to ABSODEX Driver  

- External power supply for 
ABSODEX Driver 

 

2 Check the position of the 
connectors on ABSODEX Driver 
by referring to the figure on the 
right. 

 

Main power 
connector 

Control 
power 
connector 

Actuator  
output terminal 

RS-232C 
connector 

Resolver cable 
connector 

Safety function 
terminal 

EtherNet/IP 
connector 

Emergency stop 
terminal 
Brake terminal 
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3 Connect Actuator and Resolver 
cable connector with a Resolver 
cable. 
 
 
 
Connect Actuator and Actuator 
output terminal with a Motor 
cable.  

 

4 Connect Switching hub and 
EtherNet/IP connector with a 
LAN cable. 
Connect Switching hub power 
supply to Switching hub.  

 
 
 
 
 
 
 

5 Connect the serial connector on 
Personal computer and 
RS-232C connector with an 
RS-232C cable. 

 

6 Check that the safety function is 
invalidated. 
Check that jumpers are 
connected to Safety function 
terminal. 
 
*Since the intention of this guide 
is to verify the network 
connection, the safety function 
is left invalid. 

 
*Refer to 3.2.6. Wiring for Safety 
Function of the INSTRUCTION 
MANUAL ABSODEX AX 
SERIES TS TYPE TH TYPE 
XS TYPE (SMF-2006-A) for 
wiring to Safety function 
terminal. 

 
*A jumper is connected to Safety function terminal to 
invalidate the safety function when ABSODEX Driver is 
shipped from the factory. 

Actuator 

Resolver cable 

Motor cable 

＋S1 

＋S2 

－S1 

－S2 

Personal 
computer 

RS-232C cable 

Switching hub power supply 

Switching hub 
LAN cable 
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7 Connect External power supply 
to Emergency stop terminal, 
thereby disabling the emergency 
stop of ABSODEX Driver. 
 
*Refer to 2.3.1. Wiring of 
Emergency Stop Input (TB3) of 
the Instruction Manual 
ABSODEX AX Series TS type 
TH type EtherCAT specification 
EtherNet/IP specification 
(SMF-2012-A) for wiring of 
Emergency stop terminal. 

 
 
 

 

  

External  
power supply 
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7.2.2. Parameter Settings  
Set the IP address of the ABSODEX Driver. 
The IP Address is set with AXTools. 
 

 Precautions for Correct Use 

Refer to 5.5.4. Main Power Supply Sequence of the INSTRUCTION MANUAL ABSODEX AX 
SERIES TS TYPE TH TYPE XS TYPE (SMF-2006-A) for information on the turn-on 
sequence of the main and control power supplies to the ABSODEX Driver. 

 

1 Turn ON the main and control 
power supplies to ABSODEX 
Driver. 

 

2 Start AXTools. 

 

3 The New Dialog Box is 
displayed. Select Online. 
Select the communication port 
number to be used from the 
pull-down list of Communication 
port selection.  
Click OK. 
 
 
 
 
 
 
 
 
*If there is more than one serial 
port on Personal computer, 
display Windows Device 
Manager and select the same 
port number as the 
communications port 
(displayed under Ports (COM 
&LPT)) where ABSODEX 
Driver is connected (example: 
COM1).  
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4 The dialog box on the right is 
displayed.  
Check the contents and click 
OK.  

  

5 AXTools starts up. 
 
The figure on the right shows 
the elements displayed in the 
window.   
- Tab 
- Ribbon Menu 
- View 

 
 

 

6 Select the Set Tab. 
The View of the Set Tab is 
displayed.  
Select Field Bus setting from 
the Ribbon Menu, then select 
EtherNet/IP setting. 

 

7 The EtherNet/IP register Dialog 
Box is displayed.  
Set the following parameters.  

IP address: 192.168.1.2 
Subnet mask: 255.255.255.0 
 

Click Set (ABSODEX). 
 

 

View 

Tab Ribbon Menu 
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8 The dialog box on the right is 
displayed.  
Check the contents and click 
OK.  

 

9 Click Close to close the 
EtherNet/IP register Dialog Box. 

 

10 Select the Home Tab. 
The View of the Home Tab is 
displayed.  
Select Exit from the Ribbon 
Menu to exit AXTools. 

 

11 Turn OFF the main and control 
power supplies to ABSODEX 
Driver. 
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7.3. Controller Setup 
Set up the Controller.  
 

7.3.1. IP Address Settings 
Start Sysmac Studio and set the IP address of the Controller.  
 

1 Make sure that the following 
power supplies are all OFF.  
- Switching hub power supply 

 - Controller power supply 
- Main, control and external 

power supplies to ABSODEX 
Driver  

 

2 Connect LAN cables between 
Personal computer and Built-in  
EtherNet/IP port (PORT1) on 
Controller and between Switching 
hub and Built-in EtherNet/IP port 
(PORT2) on Controller.  
Connect Power supply to 
Controller. 
 
*For information on power supply 
connection to Controller, refer to 
5-4-1 Wiring the Unit Power 
Supply of the NX-series NX102 
CPU Unit Hardware User's 
Manual (Cat. No. W593).  

 
 

 

3 Start Sysmac Studio.  
 
*If the User Account Control 
Dialog Box is displayed at start, 
make a selection to start Sysmac 
Studio.  

 

4 Sysmac Studio starts up. 
Click New Project.  

 

LAN cable 
Switching hub 

LAN cable 

CPU Unit 

Controller  

End Cover 

Power 
supply 

RS-232C cable 

Built-in EtherNet/IP 
port (PORT1) 

Built-in EtherNet/IP 
port (PORT2) 

LAN cable 

ABSODEX Driver 

Actuator 
Switching hub power supply 

Personal 
computer 
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5 The Project Properties Dialog Box 
is displayed.  
 
*In this guide, "New Project" is 
used as the project name.  

 
Check that Controller is selected 
in the Category Field of Select 
Device.  
 
 
Select the device from the 
pull-down list of Device. 
 
Select the version from the 
pull-down list of Version.  
 
*Although the following Controller 
is selected as an example in this 
guide, select Controller to be 
used. 

Device: NX102-1200 
Version: 1.31 

 

 

 

 

6 Click Create.  
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7 The New Project is displayed.  
 
The following panes are displayed 
in the window.  
Left: Multiview Explorer 

Top right: Toolbox 

Bottom right: Controller Status Pane 

Top middle: Edit Pane 

The following tabs are displayed 
in the bottom middle of the 
window.  
Output Tab Page 

Build Tab Page 

 

 

8 Double-click Built-in EtherNet/IP 
Port Settings under 
Configurations and Setup – 
Controller Setup in the Multiview 
Explorer.  

 

9 The Built-in EtherNet/IP Port 
Settings Tab Page is displayed in 
the Edit Pane.  
Check that the check box of Use 
Port 2 is selected. 
Enter the following IP address in 
the IP Address - Port 2. 

IP address: 192.168.1.1 
Subnet mask: 255.255.255.0  

  

Controller 
Status 
Pane  

Toolbox 

Edit Pane 

Multiview 
Explorer 

Output Tab 
Page 

Build Tab 
Page 
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7.3.2. Setting Global Variables 
Set global variables to use for tag data links, and create and export a CSV file in order to use 
the variables as tags in Network Configurator.  
 

1 Double-click Global Variables 
under Programming – Data in 
the Multiview Explorer.  

 

2 The Global Variables Tab Page 
is displayed in the Edit Pane.  
 
 
Click on a space to enter a 
variable in the Name Column.  
 
 
Enter EIP002_InputSignal_OUT 
in the Name Column. 
 
Enter BYTE[8] in the Data Type 
Column.  
 
After entering, check that the 
data type changes to 
ARRAY[0..7] OF BYTE. 
Select Output from the 
pull-down list of Network 
Publish.   

 
 

 
 
 

 

 

 

 

 
 

 

3 Right-click on a space under the 
entered variable, and select 
Create New from the menu to 
add a new row.   

2026/6/30 Discontinued



7．EtherNet/IP Connection Procedure 

 24 

4 In the same way as steps 2 and 
3, enter the following data in 
newly added rows.   

- Name: 
EIP002_MonitorCode_OUT 

Data Type: DINT[3] 
Network Publish: Output 

- Name: 
EIP002_Command_OUT 

Data Type: DINT[3] 
Network Publish: Output 

 
 
 

 

5 In the same way as steps 2 and 
3, enter the following data in 
newly added rows.  

- Name: 
EIP002_OutputSignal_IN 

Data Type: BYTE[8] 
Network Publish: Input 

- Name: 
EIP002_MonitorData_IN 

Data Type: DINT[3] 
Network Publish: Input 

- Name:  
EIP002_Response_IN 

Data Type: DINT[3] 
Network Publish: Input 

 
 

 

6 Select Export Global Variables 
– Network Configurator from 
the Tools Menu.  

 

7 The Save As Dialog Box is 
displayed.  
Select a location to save the file, 
and enter a file name (example: 
EIP002). 
Check that the file type is CSV 
(Comma delimited) (*.csv).  
Click Save.   
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8 Double-click Task Settings 
under Configurations and 
Setup in the Multiview Explorer.  
The Task Settings Tab Page is 
displayed in the Edit Pane.  
Click VAR.  

 

9 Click the + Button. 
 
 
 
 
A row for new entry is added.  
Click the Down Arrow Button in 
the entry cell of the Variable to 
be refreshed Column.  
 
The variables set in the previous 
steps are listed.  
Select 
EIP002_InputSignal_OUT. 
 
 
 
EIP002_InputSignal_OUT is 
added.  
 
*The relevant data types are 
automatically set for each 
variable. 

 

 

 
 

 
 

 

10 In the same way as step 9, add 
all the variables set in the 
previous steps to the Variable to 
be refreshed Column.  
 
* The relevant data types are 
automatically set for each 
variable. 
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7.3.3. Transferring the Project Data  
Go online with Sysmac Studio and transfer the project data to the Controller.  
 

 
Regardless of the operating mode of the CPU Unit, devices or machines may 
perform unexpected operation when you transfer any of the following data from 
Sysmac Studio: a user program, configuration data, setup data, device 
variables or values in memory used for CJ-series Units.  
Always confirm safety at the destination node before you transfer the project 
data.  

 

 

1 Turn ON Controller.   

2 Select Check All Programs 
from the Project Menu.  

 

3 The Build Tab Page is 
displayed.  
Check that "0 Errors" and "0 
Warnings" are displayed.  

 

4 Select Rebuild Controller from 
the Project Menu.  

 

5 The dialog box on the right is 
displayed. Check the contents 
and click Yes.  

 

6 Check that "0 Errors" and "0 
Warnings" are displayed on the 
Build Tab Page.  

 

7 Select Communications Setup 
from the Controller Menu.  
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8 The Communications Setup 
Dialog Box is displayed.  
Check that Direct connection via 
Ethernet is selected in the 
Connection type Field.  
 
Click OK. 

 

9 Select Online from the 
Controller Menu.  
If a confirmation dialog box is 
displayed, check the contents 
and click Yes.  
 
*The contents of the dialog box 
vary depending on the status of 
Controller. Check the contents 
and click on an appropriate 
button to proceed with the 
processing.   

 
 

 

10 When an online connection is 
established, a yellow line is 
displayed under the toolbar.  

 

 

 Additional Information 
For more information on online connections, refer to Section 6. Online Connections to a 
Controller of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  

 

11 Select Synchronize from the 
Controller Menu.  
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12 The Synchronization Dialog Box 
is displayed.  
Check that the data to transfer 
(example: NX102) is selected. 
Click Transfer To Controller.   
 
*After executing "Transfer To 
Controller", the Sysmac Studio 
data is transferred to 
Controller, and the data is 
synchronized.  

 

 

13 The dialog box on the right is 
displayed. Confirm that there is 
no problem, and click Yes.  
 
A screen is displayed stating 
"Synchronizing". 
 
 
The dialog box on the right is 
displayed. Confirm that there is 
no problem, and click No. 
 
*Do not return to RUN mode.  
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14 As shown in the figure on the 
right, the font color that is used 
to display the synchronized data 
changes to the same color as 
the one used to specify 
"Synchronized".  
Check that a message is 
displayed stating "The 
Synchronization process 
successfully finished". 
Confirm that there is no 
problem, and click Close.  
 
*When the Sysmac Studio 
project data matches the 
Controller data, a message is 
displayed stating "The 
Synchronization process 
successfully finished". 

 
*If the synchronization fails, 
check the wiring and repeat 
from step 1.  

 

 

15 Check that the ERR/ALM 
indicator in the Controller Status 
Pane changes to a green color 
and that PROGRAM mode is 
displayed.   
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7.4. Network Settings 
Set EtherNet/IP tag data links.  
 

7.4.1. Starting Network Configurator and Installing the EDS File 
Start Network Configurator and install the EDS file.  
 

1 Right-click the Network 
Configurator shortcut icon and 
select Run as administrator 
from the menu.   

 

 Precautions for Correct Use 

To manipulate the EDS file, you must select "Run as administrator" as described in step 1 
above to start Network Configurator.  
Otherwise, if you login with other user accounts, the following operations listed in the EDS 
File Menu cannot be applied due to user management for Windows security functions.  

EDS File Menu:  
Install, Create, Delete and Creating EDS Index Files  

 

2 Network Configurator starts 
up.  
The following panes are 
displayed in the window.  
 
Left: Hardware List 
Right: Network Configuration 

Pane 

 

3 Select Install from the EDS 
File Menu.  

 

Network Configuration Pane Hardware List 
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4 The Install EDS File Dialog 
Box is displayed.  
Select AX9000TS-U6.eds 
(EDS file) to install.  
Click Open.  
 
*For information on how to 
obtain the EDS file, refer to 
Precautions for Correct Use 
in 5.2. Device Configuration.  

 

5 The dialog box on the right is 
displayed.  
Check the contents and click 
No. 

 

6 Check that AX9000TS-U6 is 
added to the Hardware List.  
 
*It indicates that the EDS file is 
properly installed.  
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7.4.2. Uploading the Network Configuration 
Go online with Network Configurator and upload the network configuration.  
 

 Precautions for Correct Use 

Make sure that the LAN cables are connected before performing the following steps.  
If not, turn OFF the devices, and then connect the LAN cables.  

 

1 Turn ON the following power 
supplies. 
- Switching hub power supply  
- Main, control and external 
power supplies to 
ABSODEX Driver 

 

2 Select Select Interface – 
NJ/NX/NY Series Ethernet 
Direct I/F from the Option 
Menu.  
 
*The procedures with Network 
Configurator in this guide 
assume the online connection 
with Built-in EtherNet/IP port 
(PORT1) on Controller via 
Ethernet Direct I/F. 

 

3 Select Connect from the 
Network Menu.  

 

4 The Select Connect Network 
Port Dialog Box is displayed. 
Select Back Plane – 1 NX102 
– TCP:2.  
 
Click OK. 

 

2026/6/30 Discontinued



7．EtherNet/IP Connection Procedure 

 33 

5 The Select Connected 
Network Dialog Box is 
displayed.  
Check the contents and click 
OK.  

 

6 Check that the color of the 
network connection icon 
changes to blue on the 
EtherNet/IP_1 Tab displayed in 
the Network Configuration Pane.  
 
*It indicates that Network 
Configurator and Controller 
are online.  

 

 

 Additional Information 
If the online connection to the Controller cannot be established, check the cable connection.  
Or, return to step 1, check the settings and repeat each step.  
For more information, refer to 7-2-8 Connecting the Network Configurator to the Network of 
the NJ/NX-series CPU Unit Built-in EtherNet/IPTM Port User's Manual (Cat. No. W506).   

 

7 Select Upload from the 
Network Menu to upload the 
device parameters from the 
network.  

 

8 The dialog box on the right is 
displayed.  
Confirm that there is no 
problem, and click Yes.  
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9 The Target Device Dialog Box 
is displayed.  
Select 192.168.1.1 and 
192.168.1.2.  
Click OK. 
 
*If 192.168.1.1 and 
192.168.1.2 are not displayed 
in the dialog box, click Add to 
add the addresses.  

 
*The display of addresses may 
differ if any previously set 
addresses are remained in 
Network Configurator.  

 

10 The parameters of the 
connected devices are 
uploaded.  
After completing the upload, 
the dialog box on the right is 
displayed. Check the contents 
and click OK.    

11 Check that the nodes with the 
following IP addresses are 
configured in the Network 
Configuration Pane.  
- Controller (Node 1) 
IP address: 192.168.1.1 

- ABSODEX Driver (Node 2) 
IP address: 192.168.1.2 
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7.4.3. Tag Registration 
Import the created CSV file for use with Network Configurator, and register tags and tag sets.  
 

1 Right-click Controller (Node 1) 
in the Network Configuration 
Pane and select Parameter – 
Edit from the menu.  

 

2 The Edit Device Parameters 
Dialog Box is displayed.  
Click To/From File. 

  

3 Select Import from File.  
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4 The Import Connection 
Configuration Dialog Box is 
displayed.  
Select EIP002.csv and click 
Open.  
 
*"EIP002.csv" is the file 
created in step 7 of 7.3.2. 
Setting Global Variables.  

 
*If you have opened the Tag 
Sets Tab Page (not 
Connections) and have 
perform steps 2 to 4, the 
dialog boxes (1) and (2) 
shown on the right will be 
displayed.  
Simply follow as below. 

 
The dialog box (1) is 
displayed. Confirm that there 
is no problem, and click Yes.  

 
The dialog box (2) is 
displayed. Confirm that there 
is no problem, and click No. 

 
*Do not automatically 
create a tag set from the 
tags you import.  

 
 
 
 
Dialog box (1) 

 
Dialog box (2) 

 

5 Click the Tag Sets Tab in the 
Edit Device Parameters Dialog 
Box.  
Click the In - Consume Tab, 
and then click Edit Tags.  
 
*Follow steps 5 to 12 to create 
and register an input tag set 
of Controller (Node 1).  
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6 The Edit Tags Dialog Box is 
displayed.  
Click the In - Consume Tab. 
 
Check that the tab page shows 
the variable names that are 
described in 6.3. Tag Sets and 
have been set in 7.3.2. Setting 
Global Variables.  
 
Click OK. 

 

7 Click New in the Edit Device 
Parameters Dialog Box.  
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8 The Edit Tag Set Dialog Box is 
displayed.  
Select 
EIP002_OutputSignal_IN from 
the Candidate Tag List.   
Click the << Button.  
 
 
 
 
 
 
 
Check that 
EIP002_OutputSignal_IN is 
registered in the Tag List.   

 
 

 

9 In the same way as step 8, 
individually select all the other 
variables displayed in the 
Candidate Tag List and 
register them in the Tag List in 
ascending order of IN No. 
listed in 6.3. Tag Sets.  
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10 Enter EIP002_IN in the Name 
Field.  
 
Click Regist.  

 

11 The Edit Tag Set Dialog Box is 
displayed again. Click Close.  

 

 

12 Check that the following tag 
set information is displayed on 
the In - Consume Tab Page of 
the Edit Device Parameters 
Dialog Box.  

Name: EIP002_IN 
Size: 32 Byte 

 

13 Click the Out - Produce Tab in 
the Edit Device Parameters 
Dialog Box.  
Click Edit Tags.  
 
*Follow steps 13 to 19 to 
create and register an output 
tag set of Controller (Node 1).  
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14 The Edit Tags Dialog Box is 
displayed.  
Click the Out - Produce Tab. 
 
Check that the tab page shows 
the variable names that are 
described in 6.3. Tag Sets and 
have been set in 7.3.2. Setting 
Global Variables.  
 
Click OK. 

 

15 Click New in the Edit Device 
Parameters Dialog Box.  

 

2026/6/30 Discontinued



7．EtherNet/IP Connection Procedure 

 41 

16 The Edit Tag Set Dialog Box is 
displayed.  
In the same way as steps 8 
and 9, individually select all the 
variables displayed in the 
Candidate Tag List and 
register them in the Tag List in 
ascending order of OUT No. 
listed in 6.3. Tag Sets.  

 

17 Enter EIP002_OUT in the 
Name Field.   
 
Click Regist.  

 

18 The Edit Tag Set Dialog Box is 
displayed again. Click Close.  

 

 

19 Check that the following tag 
set information is displayed on 
the Out - Produce Tab Page of 
the Edit Device Parameters 
Dialog Box.  

Name: EIP002_OUT 
Size: 32 Byte 
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7.4.4. Setting Connections 
Set connections to associate the tag sets of the target device with the tag sets of the originator 
device.  
 

1 Click the Connections Tab in 
the Edit Device Parameters 
Dialog Box.  
Select 192.168.1.2 from the 
Unregister Device List and 
click .  

 

2 192.168.1.2 is registered in the 
Register Device List.  
Select 192.168.1.2 and click 
New.  

 
  

2026/6/30 Discontinued



7．EtherNet/IP Connection Procedure 

 43 

3 The Edit Connection Dialog 
Box is displayed.  
Set the values (listed in the 
following table) in the 
Connection I/O Type, 
Originator Device and Target 
Device Fields.  
 
Click Regist.  

 
 

Editing settings for connections  
Setting item Setting value 

Connection I/O Type Exclusive Owner 
Originator Device Input Tag Set EIP002_IN-[32 Byte] 

Connection Type Point to Point connection 
Output Tag Set EIP002_OUT-[32 Byte] 
Connection Type Point to Point connection 

Target Device Output Tag Set Input_101-[32 Byte] 
Input Tag Set Output_102-[32 Byte] 

 

4 The Edit Connection Dialog 
Box is displayed again.  
Click Close.  

 

5 The Edit Device Parameters 
Dialog Box is displayed.  
Check that the connections set 
for 192.168.1.2 are registered.   
 
Click OK. 
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6 The IP address of Controller 
(Node 1) is displayed under 
ABSODEX Driver (Node 2) in 
the Network Configuration 
Pane.  
 
*It indicates that the 
connection settings are 
completed.  
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7.4.5. Transferring the Tag Data Link Parameters 
Transfer the tag data link parameters to the Controller.  
 

1 Right-click Controller (Node 1) 
in the Network Configuration 
Pane and select Parameter – 
Download from the menu.   

 

2 The dialog box on the right is 
displayed. Confirm that there is 
no problem, and click Yes.  

 

3 The tag data link parameters 
are downloaded from Network 
Configurator to Controller. 

 

4 The dialog box on the right is 
displayed. Check the contents 
and click OK.  
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7.5. EtherNet/IP Communication Status Check 
Confirm that the EtherNet/IP tag data links are performed normally.  
 

7.5.1. Checking the Connection Status 
Check the EtherNet/IP connection status.  
 

1 Check with LED indicators on 
Controller that the tag data links are 
performed normally.  
 
The LED indicators in normal status 
are as follows:  

NET RUN: Green lit 
NET ERR: Not lit 
LINK/ACT: Yellow flashing  

(Flashing while packets are 
being sent and received.) 

 
*The NJ-series Controllers also 
have the same LED indicator 
status.  

 
 
 
 
 

 

2 Check the LED indicators on 
ABSODEX Driver. 
 
The LED indicators in normal status 
are as follows:  

MS: Green lit 
NS: Green lit 

 
 

 

3 The normal performance of tag data 
links can be confirmed with the 
status information displayed in the 
Monitor Device Dialog Box of 
Network Configurator.  
 
Right-click Controller (Node 1) in the 
Network Configuration Pane and 
select Monitor.  

 
 
 

 

Built-in EtherNet/IP (Port 2) 

Status Indicators 

NS 

MS 
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4 The Monitor Device Dialog Box is 
displayed.  
Check that the following check 
boxes are selected on the Status 1 
Tab Page.  
・On-Line 
・All Tag Data Link 
・Tag Data Link 
・Ethernet Link Status 
Check that the target node status is 
displayed as shown on the right.  
 
Click Close. 

 

5 Select Disconnect from the 
Network Menu.   

 

6 Check that the color of the network 
connection icon changes to grey on 
the EtherNet/IP_1 Tab displayed in 
the Network Configuration Pane.  
 
*It indicates that Network 
Configurator and Controller are 
offline.   

 

7 Select Exit from the File Menu to 
exit Network Configurator.  

 

Number: Node number 
Blue: Connection normal  
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8 A confirmation dialog box is 
displayed asking whether to save 
the parameters in a network 
configuration file.  
Confirm that there is no problem, 
and click No.  
 
*If you wish to save the parameters 
in a network configuration file, click 
Yes to save the parameters.  
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7.5.2. Checking Sent and Received Data 
Check that correct data is sent and received.  
 

 
If you change the variable values on a Watch Tab Page when Sysmac Studio is 
online with the CPU Unit, the devices connected to the Controller may operate 
regardless of the operating mode of the CPU Unit.  
Always ensure safety before you change the variable values on a Watch Tab 
Page when Sysmac Studio is online with the CPU Unit.  

 

 

1 With Sysmac Studio, select Watch 
Tab Page from the View Menu.  

 

2 The Watch (Project)1 Tab Page is 
displayed.  

 

3 Click Input Name and enter the 
following variable names for 
monitoring.  

EIP002_MonitorCode_OUT[0] 
(Monitor code 1) 

EIP002_InputSignal_OUT[4] 
(Bit 0: Monitor output 
execution request) 

EIP002_MonitorData_IN[0] 
(Monitor data 1) 

 
 
 

 

4 Select the display format for each 
variable as follows: 

EIP002_MonitorCode_OUT[0]: 
Decimal 

EIP002_InputSignal_OUT[4]: 
Binary 

EIP002_MonitorData_IN[0]: 
Decimal 

 

 

… 
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5 Check that the following online 
values of the variables are 
displayed. 

EIP002_MonitorCode_OUT[0]: 
0 

EIP002_InputSignal_OUT[4]: 
0000 0000 

EIP002_MonitorData_IN[0]: 
0 

 
 

 

6 With AXTools, select the Monitor 
Tab. The View of the Monitor Tab 
is displayed. Select Motion from 
the Ribbon Menu. 
 
*If AXTools is not started, refer to 
7.2.2. Parameter Settings to start 
AXTools, then connect to 
ABSODEX Driver again.  

7 The Operation order menu Dialog 
Box is displayed. 
Check the value of Current 
position (Actuator) in the Present 
operation situation.  
(450748 pulses in this example) 

 

8 On the Watch Tab Page in 
Sysmac Studio, enter 3 in the 
Modify Column for 
EIP002_MonitorCode_OUT[0]. 
 
The online value of 
EIP002_MonitorCode_OUT[0] 
changes to 3. 
 
*For the above mentioned variable 
(Monitor code 1), set the code 
No. of the monitored item that is 
selected to be fetched into 
Monitor data 1. 
Here, the code No. 3 is set as an 
example, which indicates the 
current position in full rotation 
(pulse). 
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9 Enter 0000 0001 in the Modify 
Column for 
EIP002_InputSignal_OUT[4]. 
 
*The value of the code No. 3 
(current position in full rotation 
(pulse)) that is set in step 8 can be 
stored by changing bit 0 of the 
above mentioned variable to 1 
(monitor output execution request 
ON). 

 
 

 

10 Check that the following online 
value is displayed. 

EIP002_MonitorData_IN[0] 
(Monitor data 1): 450748 

 
*This indicates that Controller has 
received 450748 as the current 
position in full rotation (pulse) of 
ABSODEX Driver, which is the 
same as the value checked in 
step 7. 

 
*The value of the current position 
in full rotation (pulse) varies 
depending on ABSODEX Driver 
used.  

 

 

 

 Additional Information 
For more information on how to output monitor data using monitor codes, refer to 3.3. Monitor 
Code/Command Code and 3.4.1. Monitor Code of the Instruction Manual ABSODEX AX 
Series TS type TH type EtherCAT specification EtherNet/IP specification (SMF-2012-A). 
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8. Initialization Method 
 
The setting procedures in this guide are based on the factory default settings.  
Some settings may not be applicable unless you use the devices with the factory default 
settings.  
 

8.1. Initializing a Controller 
To initialize a Controller, clear all memory of a CPU Unit.  
Change the operating mode of Controller to PROGRAM mode and select Clear All Memory 
from the Controller Menu in Sysmac Studio. The Clear All Memory Dialog Box is displayed. 
Check the contents and click OK.  

 
 
 

8.2. Initializing a CKD ABSODEX Driver 
For information on how to initialize a CKD ABSODEX Driver, refer to 3-2-1-4 ABSODEX 
initialization of the INSTRUCTION MANUAL ABSODEX AX Tools for Windows® Common for 
TS-Type, TH-Type, MU-Type and XS-Type Drivers (SMF-2005-A). 
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9. Revision History 
 

Revision 
code 

Date of revision Description of revision 

01 December 2018 First edition 
   
   

 

2026/6/30 Discontinued



 

 54 

 
 
 

2026/6/30 Discontinued



2018

1218(1218)   P713-E1-01

2026/6/30 Discontinued


	1. Related Manuals
	2. Terms and Definitions
	3. Precautions
	4. Overview
	5. Applicable Devices and Device Configuration
	5.1. Applicable Devices
	5.2. Device Configuration

	6. EtherNet/IP Settings
	6.1. Parameters
	6.2. Global Variables
	6.3. Tag Sets

	7. EtherNet/IP Connection Procedure
	7.1. Work Flow
	7.2. CKD ABSODEX Driver Setup
	7.2.1. Cable Connection
	7.2.2. Parameter Settings

	7.3. Controller Setup
	7.3.1. IP Address Settings
	7.3.2. Setting Global Variables
	7.3.3. Transferring the Project Data

	7.4. Network Settings
	7.4.1. Starting Network Configurator and Installing the EDS File
	7.4.2. Uploading the Network Configuration
	7.4.3. Tag Registration
	7.4.4. Setting Connections
	7.4.5. Transferring the Tag Data Link Parameters

	7.5. EtherNet/IP Communication Status Check
	7.5.1. Checking the Connection Status
	7.5.2. Checking Sent and Received Data


	8. Initialization Method
	8.1. Initializing a Controller
	8.2. Initializing a CKD ABSODEX Driver

	9. Revision History



